Tutorial for SMART Notebook 11.2.notebook

Welcome to the SMART Notebook™ 11.2
collaborative learning software tutorial

Review features and

(e~ )
get started quickly.

SMART Notebook 11

SMART
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Introducing SMART Notebook 11.2

SMART Notebook software is now faster and better than ever, with an
intuitive SMART Ink™ experience and support for more operating systems.
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New features in SMART Notebook 11.2

Toggle the zoom level

Switch quickly between the two most common zoom levels,
Entire Page and Page Width, by adding this button to your

toolbar.

This button is also available on the Full Screen toolbar. o=

How to customize your toolbar

[\

.
SMART Notebook Preferences | | M =]

| General | Defautts | SMART Response |

Image optimization

[ sk every time linsert @ large image -
Mare informati

Default background color for new pagss

Currert default I Change Color ;

Mote: This setting affects new pages I I I O O O O O fores you
apply AEEEEEEEN
More information EEEECOEEN

OEOEECOER
Measurement tool color Ol DDD ~ialn

Eﬁmaﬂdaﬂ for light bad _JM

Mare information

Table cell padding
Add cell padding to table cells

Mote: This setting affects new and existing tables. It will take effect the next time you start
SMART Notebook software.

Mare information

I
—r

Entire Page/Page
Width Display

= . Haanm -

Change the default page background color

You can change the default page background
color in SMART Notebook Preferences.

How to edit your Preferences

Looking for add-on preferences? Try the Add-on Manager

July 18, 2018



Tutorial for SMART Notebook 11.2.notebook July 18, 2018

New features in SMART Notebook 11.2

R Turn off Extend Page
St Oy : ‘ Prevent your pages from becoming longer by
| .
fatend Page »[+ on turning off Extend Page.
Page Border 3 o
Augrenert | Access this option from View > Extend Page.
E Fill Effects %
Line Style

Customize ink fade times | Page Pecordes |
You can type in a custom value for ink fade time. m% 9 5

Remember to press Save Tool Properties to save
your changes as a default ink style on the toolbar.

| Enable ink to fade after you write it

Fade after (seconds)

Save Tool Properties ]
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Write and draw

Pick up a pen and write
Press a pen color button on the pen tray to change the pen color.

Writing on your SMART Board® interactive whiteboard

On-screen keyboard
Press the Keyboard button to launch the

on-screen keyboard.

Right-click
To make your next touch a right click, press
the Right-Click button on the pen tray.
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Adaptive toolbar

The toolbar provides shortcuts to
commonly used actions, tools and

properties. When you use the Select

tool to select an object in the work
area, its properties appear to the
right of the tools group.

Press to reveal

Actions . Properties
/_\‘/% /_\—/%
N _,'Lf)(“ﬂn_;[wﬁ(@g ] H ‘P[:]

QoA T,.XTER WE /7
Tools
Remember

You can still find additional
properties in the Properties
tab and in the object’s
drop-down menu.

\[ﬁl

4l

@B

........ ?C\

Clone
Cut

Copy
Paste
Delete

Infinite Cloner

SetImage Transparency...

Optimize Image...

Lock
Group
Flip
Order

Link...
Sound...
Properties...

Ctrl+D
Ctrl+X
Ctrl+C
Ctrl+V

Del

r v v v
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Improved toolbar customization

Customize the toolbar so that the buttons you use frequently are only one click away.

e 225 eEme o (3 P

Customize Toolbar I
1/
Actions Add or remaove items by dragging them to or from the toolbar V
Add-ons E E E ; Q E] ‘ D—j
| Blank Page Classroom Audio Clear Ink Clear Page Clone Clone Page
i
s % ) X o Wi o
- Copy Cut Delete Delete Page Dual Write Mode Dual/Single Page
Display
= e
- ] A 4 &
Entire Page/Page Full Screen Insert Compass Insert Geodreieck Insert Protractor Insert Ruler
Width Display

ispla;
N r] \i’ﬁ = 3 G
Instant Conferencing Internet Browser  \Measurement Tools Mext Page Open Paste
@ e o -
Restore Default Toolbar ] [ Restore Default Tool Properties l \
\ Drag to add
\

0 G > I WA
‘i--bEEE _E‘HJ_ =

-
MK .0
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Pages

White and draw

Adapte Toolbar

" See and sort your pages

Use the Page Sorter tab to jump to a page by
selecting its thumbnail, or reorganize your pages
by dragging them into a different order.

Reset Page
Easily reset your page to its last saved state, without
reopening your lesson file.

m

Insert Blank Page Ctrl+M

Clone Page Ctrl+D

Rename Page

Delete Page Del
! Clear Page Ctrl+L

Clear Ink from Page

Mov 28-3-30 P Screen Shade
Set Background Fill...
g Remove Theme
Show All Links Alt+L

Add Page to Gallery
New ?78-3-30P T
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Objects

Resize and rotate
Move objects

Press the leaf to select. _
To rotate, use the green handle. Press the leaf and drag it to
move it around the page.

To resize, use the white handle.

' V4

Remember

S

To select an object, switch back to Select mode by & &
putting down the pen and then pressing the Select icon. A /|
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Text objects

Add text
Click the Text button on the toolbar,
and then click the work area to create

a text box. Start typing. ‘

You can format text using the buttons
in the toolbar or the options in the
Properties tab or the Format menu.

Press to reveal

Edit text
Double-click the text box to edit text. -

Resizing the text box _ _

Drag the white handle to adjust the Try it here! Double-click the text
length of the text box and reflow the /< to the left and use the white
text inside. handle to adjust the text box.

July 18, 2018
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Gallery content

Find content in the Gallery
E Find images, videos, sound files, interactive activities, backgrounds
and SMART Notebook pages in the Gallery. Just drag and drop to

add them to your page.
E & Typesearchtermshere v § Seach
> aEEE '
Add interactivity with the Lesson Activity Toolkit £ | R e fken ]
. ..a English and Language Arts
J— The Gallery tab also contains templates to help e | 53 ey
you create your own activities and engage your r ——— :
ﬁ students with interaction. e EF
4 | Pictures (657)
p— E
- ‘o1
2 =
N Half - orange

nnnnn

e ¥ 4
e
fe

[] Auto-hide
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Notebook Gallery 2.0 Beta

July 18, 2018

Test-drive the Notebook Gallery 2.0 Beta and search both online and offline Gallery

resources with ease.

..ﬂ Gallery Essentials -
..ﬂ Lesszan Activity Toolkit 2.0

..ﬂ Lesson Activity Examples
..0» SMART Exchange

L.

) i Notebook Gallery 2.0 B-etaE

Click the link in the Gallery to visit the
Notebook Gallery 2.0 Beta channel,
where you can learn more about the

beta program and how to participate.

Click here
to download

ﬁ

Preview

12
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Sound recorder

Record a short sound clip to attach to an object on the page.

¢

l

Clone
Cut
Copy
Paste
Delete

Infinite Cloner

Show/Hide Vertices
Show/Hide Interior &ngles
Show/Hide Side Lengths
Divide Shape...

Check 5pelling...

Lock
Group
Flip

Properties...

Ctrl+D
Ctri+X
Ctrl+C
Ctrl+¥

Del

=
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7
Insert Sound &u
From file
Sound to play:
| [ Browse... ]

R und dip
L Current recarding length:

00:00 Start Recording

q @ Recording name:
N
wdings can't be longer than 01:00. /

Preview Sound

Play by pressing: @ Cormericon () Object

Remove Sound

Attach Sound | [Canoel ] ’ Help ]

13



Tutorial for SMART Notebook 11.2.notebook July 18, 2018

Activity Builder

Create interactive lesson activities easily by using the Activity Builder. To
start, click the Add-ons tab, and then click the Activity Builder thumbnail.

Try it What do horses eat?
K/> Drag and drop foods over the horse to feed it.

tad

Use it in your class today

LYY A

& Type search terms here ¥ F

£1-£ Lesson Activity Examples ~| Need some inspiration? There are many
= more activity examples in the Gallery.

- Interactive Technigques H

.= Trimble 30 warehouse
.. 2% Notebook Gallery 2.0 Beta i
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B rOWSG r Press to reveal

Browse the Internet without leaving ’
your SMART Notebook file.

Blank Page Ctrl+M

Picture... -
Picture From Scanner...

Video...

Adobe Flash Player Compatible File...

Y]

Gallery Item...

SMART Notebook

Sound...

Internet browser

Graph Table...
Graph...

m

Browse to any web page within SMART Notebook
collaborative Ieg:(ging software.

Equation

Meazurernent Tool k

Internet Browser

SMART Document Camera Viewer TO see the same Web page

. every time you open the file, B
SMART Response Question... Pin the P
SMART Response Title Page... preSS n € Fage.

,(-@ To return to that page, press
™ Go Back to Pinned Page.
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Press to reveal

The customizable settings include the following:

woomrees W 5 W W @A, =)
e
General | Defauls | SMART Response |

L4 Changing the defaUIt page baCkground SMART Motebook is cumently the default program for notebook files.

Preferences

SMART Notebook Preferences gives you detailed
control over your user experience.

COIO r [ Make Defaut |
" []Tel me i SMART Notehook softwars isnt the defaukt prodram for notehook filesi

Shake gesture

« Enabling or disabling the shake gesture s etk gt b g o o i
and the preSS'and'hOId gesture. [] Press and hold to pefor) —™ ™ —— ——————__— _______ __ —

More information on qesture: ‘ General ‘ Defaults |5MAF{T Hﬂponse‘

Image optimization
Hardware I 9z opt

« Enabling or disabling hardware 5 s s | o e 3]

MNotebook software.

acceleration (disable it if your content ottt
d OeS n ,t d i S p | ay CO rreCtIy a n d S MA RT Mate: This sem.ng affects new pages on?van::':vemdden by any themes you

Notebook software isn’t responding).

Measurement tool color
[Blue tirt frecommended for ight backgrounds) -

e Changing the measurement tools’ '

CO I O r Table cell padding
’ Add cell padding to table cells

Note: This setting affects new and existing tables. it will take effect the next time you start
SMART Notebook software

« Adding or removing cell padding in

ta b I eS Looking for add-on preferences? Trv the Add-on Manager
.

0

| 7]

Access SMART Notebook Preferences from Edit > Preferences
(Windows) or Notebook > Preferences (Mac).
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Download lessons

Download teacher-created lessons from the SMART Exchange™ website

Search by subject and grade. See what other teachers are trying and
loving. Download and modify lessons to suit your teaching style.

S |\/| ART EXC h an g e Signin | Join for free! | BE United States

Find Lesson Plans for Your SMART Board and Connecl t with Teachers
= My cart

“ Search Share a Resource Standards-Aligned Community ¥ Training ¥

I IR
~ *E'“_E“_B@

Search All Resources

Lessons, ima ges and more

X | 5
( 3 MRl
Browse by: exchange.smarttech.com
Subject(s) Grade(s) File Type

Art and Design Citizenship Cross-curricu lar English as a Second Language

English Language Arts Geography Health and Physical Education History O th S MART E h b 't

ICT Library and Infermational Science Mathematics Modem Foreign Languages pe n e XC a n g e We S I e

Music Other Religion Science

Social Studies Special Education

in your web browser or click the
Top Downloads more) Featured Premium resources (morz) toolbar icon ‘to go there direCtly.

G ry-Exterior
_:?J;---_!'EL Let's Celetrate!

g

g N

= 0

L J) school

eomet|
les o

f a Polygon
RT Notebook lesson
dleback Educational Publishing

JEOPARDY!
]

The Mitten 100 days of school Contractions Jeopardy Template for
SMART Notebook lesson SMART Notebook lesson SMART Notebook lesson SMART Response
SHMART Notebook lesson

= Spinner Game Gr.
=\ | PK-2: Algebra
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SMART Board interactive whiteboard

On the following pages, features with this k. 3 symbol
are available only on SMART Board 800 series
interactive whiteboards or certain other SMART
hardware products.

Refer to your interactive product’s specifications
(available from smarttech.com/support) to
determine which features it supports.

For additional resources related to your SMART hardware product,
visit smarttech.com/training.

July 18, 2018
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Gestures

Click the buttons to view the ge

July 18, 2018
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Using object awareness [

Work more naturally

The interactive whiteboard’s cameras detect the size of your touch and assign different

tools accordingly. This enables you to use your finger or pen to write or select, and your
palm or fist to erase.

Click the box below to view object awareness in action.

Use the pen to write, your finger to drag and
your palm to erase.

Try it here —7

A video has been created to further explain the concept of object awareness and
touch recognition here: http://youtu.be/IBMdi1XM9mc

i LB |

July 18, 2018
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Lockable pen optionz

Play the video file to view the gesture.

If you want to use your SMART Board interactive whiteboard
with a rolled up sock, Koosh® ball, tennis ball or pointer, enable
the Lockable pen option.

Press and hold a pen color button until it flashes. This
locks the interactive whiteboard so you can use any tool,
not just your finger or pen, with the interactive
whiteboard. Use your tool of choice to write, or press any
toolbar tool to change the tool’s function.

Press another pen color button to disable the Lockable pen
option and go back to using your pen, finger and palm.

21
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Explore other SMART products

Click the products below to learn what’s new and more!

SMART Ink
Introducing SMART Ink!

SMART Document Camera™

SMART Table® collaborative
learning center

g SMART Notebook Math Tools
7T

SMART Response interactive
E response software
What's new in SMART Response 2013

u SMART Sync™ classroom
—_—"

management software

July 18, 2018

22



Tutorial for SMART Notebook 11.2.notebook July 18, 2018

Now try it yourself

SMART Notebook 11

SMART

© 1565 - 3013 SRAART Techinol ogies

Start exploring and creating.

For additional help, tutorials or information on training sessions, use the Help
menu or go to smarttech.com/training.

23



Attachments

Q  Tutorial for SMART Response 2013.notebook





images/clipboard(6).png

Add-ons

bl SMART Notebook Help Ft
e SMART Response Help

e
—— DK Tutorial

Submit Feature Request,
Saftware Actvation.
Check for Updates and Activation.

About SMART Notebock

S









images/clipboard(10).png









images/Response Icon.JPG









images/clipboard(4).png

LK)

OB G
- » = L] (i ]
QA "X Wwa-a
L Assessment Started
= Studets neetthe folowingnformetion o cornect
| (propertes [ 7 )
2|, X Website:
| InProgress:
. response.smarttech.com
A | Duration: 00:1

e e

PIPI¥

1 No stude|
Assessment [D:

Who isn't fin

= 821253

[ Auto-hide. v









images/clipboard.png

Tags

Showtags for

Calfaria

Grade 7 | [science More optons

Select tags for tis queston

& Recent Tags
[CJSCL7.5 2.8 Students know plant and arima clls contai many thousandsofcifrent genes and bpical have two copiesof every e, The two o
[CJSC17.5 2.2 Stuents knowth diferences between the lfscycls and eprodction melhods of sexual and asesual igansms
[CJSC1.7.5.2. Students know an herted i can be delemined by ane o more genes.

[CJSCL7.5 25 Students know sesus tspoduction rodcesoffspingthat her hal et genes fom each paert
[Isping 2013

[Jénabeing

[ 4ppbing

] Understanding

(] Remenbeiing

[CISCL7.L5 1. Students know thal s mliceluarcrgaisms develo, thi el iferrtste

Calfria Cortent Standards

Bloomis Cognive Levels

Maizano's Cogiive Levels

Custom Tags

al )

Tags for tis questi:

T )









images/clipboard(1).png

Insert Question

Type your question below: (Students answer yes or 10.)

T Century Gothic: v|zlv/B 7 U B =

Education standards and other tags









images/clipboard(5).png

-

= @

OB G
QA "X F

E Trig Quiz 1 =
Title page

(s [ [oisos)

o &)lE s mlc]

Description
Title:  Trig Quiz 1

Type:  Quiz -
Subject

Topic:

Summary

This assessment has no questions in it
Add a question to the next page

Assessment Delivery Mode
Allow al students to answer:









images/clipboard(3).png

Response VE - Sign In Request

The folowing student(s) e aleady signed in, but want 1o sign in using a
diferent device.

Select who can sign n using a diferent device:

] Katie Bel -
[ Stewat Ackerley

] DerielChen

[ Timothy Smith v

Note: This il sign them aut of the device theye curent)y signed i on.









annotationmetadata/metadata.xml

    URI http://www.adlnet.org/metadata/MDO_01 LOMv1.0 SCORM_CAM_v1.3   URI http://tempuri.org/randomid?id=2FD9B1A7-9EB6-4C51-BB55-4C5576E0499A  ﻿  ﻿  ﻿  application/x-smarttech-galleryitem;x-original-type=image/png    LOMv1.0 browser  LOMv1.0 x-smarttech-notebook ms-windows:9.5;macos:9.5;unix:9.5   LOMv1.0 no  LOMv1.0 yes  ﻿  2012-11-21T13:43:43  1.0  LOMv1.0 final






images/clipboard(2).png

sponse Teacher Tool

File  Edit Pivacy  Help

20 4]

Import  Delete Notebaak

=
Privacy. Off
[l Gradebook

Sience 8 (Period #)

II Student Performance

Sumrmarize individual student performance
Science 8 (Period B)

Temp

Grade @ @ Choose areport type:

@ Anonymous Mode

Adda Class Educational standards
Gognitive levels

Question performance
Perfarmance summary

Class Performance

Student Comparison

| @ Choose report parameters:

Class Comparison
Classes Science 8
Students: Al students selected Change.
Assessments; All assessments selected Change.
Performance threshold: [0 | % performance = [100] %

Show:. @ Barchat O Line chart

Provew | | savereport, | | Bpon | | Greate FOF









annotationmetadata/metadata(28).xml

    URI http://www.adlnet.org/metadata/MDO_01 LOMv1.0 SCORM_CAM_v1.3   URI http://tempuri.org/randomid?id=DEF5CAB0-AFE4-4CCF-9770-45D44F64ABD0  ﻿  ﻿  ﻿  application/x-smarttech-galleryitem;x-original-type=image/xml+svg;x-smarttech-notebook-text=yes    LOMv1.0 browser  LOMv1.0 x-smarttech-notebook ms-windows:9.5;macos:9.5;unix:9.5   LOMv1.0 no  LOMv1.0 yes  ﻿  2011-01-07T15:56:27  1.0  LOMv1.0 final






annotationmetadata/metadata(7).xml

    URI http://www.adlnet.org/metadata/MDO_01 LOMv1.0 SCORM_CAM_v1.3   URI http://tempuri.org/randomid?id=9F9029A7-3200-457B-99CE-4E85BC777D4B  ﻿  ﻿  ﻿  application/x-smarttech-galleryitem;x-original-type=image/xml+svg    LOMv1.0 browser  LOMv1.0 x-smarttech-notebook ms-windows:9.5;macos:9.5;unix:9.5   LOMv1.0 no  LOMv1.0 yes  ﻿  2012-01-16T17:49:32  1.0  LOMv1.0 final






settings.xml

 






imsmanifest.xml

   ADL SCORM CAM 1.3 metadata.xml    What's New in SMART Response 2013                                        






metadata.xml

    URI http://www.adlnet.org/metadata/MDO_01 LOMv1.0 SCORM_CAM_v1.3   URI http://tempuri.org/randomid?id=7345BA2E-595A-4B12-AD7E-0142B24B2278  ﻿  ﻿  ﻿  application/x-smarttech-notebook    LOMv1.0 browser  LOMv1.0 x-smarttech-notebook ms-windows:9.5;macos:9.5;unix:9.5   LOMv1.0 no  LOMv1.0 yes  ﻿  2011-11-28T10:51:32  1.0  LOMv1.0 final






preview.png

Waloome to the SMART Response™
2013 o inats e g









assessment.xml





metadata.rdf

 







metadata.db





page0.svg

  Welcome!     Welcome to the SMART  Response™   2013  software What's New guide    Review new features and   get  started quickly                                                               To access this guide later, go to    Then click the  What’s new in SMART   Response 2013  link on the last page.
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  VE persistent IDs     Persistent assessment IDs for   SMART Response VE    Use the same Assessment ID for single or instant questions. Students no longer   need to sign in multiple times!        The Assessment ID    changes only when a   new class is started.  
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  Recent tags       Recent tags    Tag questions faster when you’re reusing the same set of tags:   · Education standards from your local state/province   · Cognitive levels from several popular cognitive level scales   · Custom tags that you create      Easily reuse recently used tags!    
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  VE whole class mode      Whole class mode for   SMART Response VE    Teachers can now choose to deliver their   assessment in self-paced or whole class mode.       In self-paced mode, students can answer all   questions at their own pace (same as in   SMART Response 2012).       In whole class mode, students can answer only   the question that’s displayed on the   SMART Notebook™ page.    
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  What's new     Introducing SMART Response 2013    New features and enhancements   · Easily tag questions with recently used tags   · Create reports based on student or class performance criteria   · Operating system support for Mac OS X 10.8 (Mountain Lion) and Windows® 8      SMART Response VE improvements   · Use the same Assessment ID during a class session – students no longer need to   sign in multiple times (available in SMART Response 2012 SP1)   · Control the pace of the assessment using whole class mode   · Prevent cheating and login errors – students can now sign in from  only  one device   · Support for using SMART Response VE with proxy servers      
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  VE sign-in control     Sign-in control for SMART Response VE    Students can now sign in from  only one  device at a time, which reduces cheating   and sign-in errors.       If a student needs to switch   devices, you can grant him   or her permission to do so. 
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  Performance criteria        Performance criteria for reports    Quickly identify areas   students don’t understand   by generating reports for   students or classes meeting   a specific performance   criteria.   If at least one item meets   the performance criteria,   then a report for that student   or class is generated.  The   report includes only the   subset of items that meet   the performance criteria.
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  Proxy server and operating system support     Proxy server and operating system support    Proxy server support for SMART Response VE   SMART Response VE now works with proxy servers (configured by   your system administrator, if applicable).    Additional operating system support   SMART Response is now supported for:   · Mac OS X 10.8 (Mountain Lion)   · Windows 8
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  Start exploring     Now try it yourself!    Start exploring and creating.     For additional help, tutorials or information on training sessions, use the Help    menu or go to                                     .    smarttech.com/training   
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